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1 Document Purpose 

The FAMIS Training & Business Rules procedure introduces the concept of the Facilities 
Management Information System (FAMIS), the reasons for its development as a management tool, 
and to improve the management of assets within Agencies and sites to provide facilities 
management arrangements. The document also provides users with an understanding of the 
FAMIS functionality and is intended to provide guidance to the FAMIS business rules that bring 
about the AGFMA (Across Government Facilities Management Arrangements). 

2 Document Scope 

This document’s scope contains applicability and coverage details such as FAMIS terms and 
concepts, business rules, logging on and navigating, work tabs, data entry techniques, tips and 
hints. The FAMIS training procedure concentrates on the business rules and why certain rules 
apply and how to perform various functions in FAMIS using corresponding hyperlinks to work 
instructions, desktop aids and forms. 

3 Introduction 

The Facilities Management Information System (FAMIS) allows registered users to; 

 electronically request and track jobs,

 accept their physical completion and

 approve financial payment.

It also provides information on scheduled work and a history of agreed costs. The Facilities 
Management Information System (FAMIS) is a program designed to be used by staff and 
management who are responsible for the management and implementation of systems pertaining 
to the Across Government Facilities Management Arrangements (AGFMA). 
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4 Services Available 

There are a number of decisions to be made before requesting work in FAMIS. These include; 

 What type of work it is?

 How urgently it must be done?

 What is the estimated cost of the work?

It should be noted that the account code, where applicable, allows Agency Representatives to 
choose which of their chart of accounts appears on the invoice to enable payment from the 
appropriate funds.  The classification of work type (e.g. breakdown or minor works) is for the work 
to be appropriately classified in FAMIS and does not affect the payment by Agencies. The function 
of FAMIS is to improve the management of assets through its ability to enable Agencies and sites 
to procure the following services: 

Planned Services 
 Preventative Maintenance
 Planned Replacement/Refurbishment Maintenance
 Planned Minor Works
 Small Construction Works

Unplanned Services 
 Breakdown Maintenance
 Scheduled Attendance
 Unplanned Property Services
 Unplanned Replacement/Refurbishment Maintenance
 Unplanned Minor Works

Property Services 
 Cleaning Services
 Hygiene Services
 Security Services
 Grounds Maintenance
 Waste Management

 Enable the Agency representatives to follow up on the progress of work requests and allow 
Agency representatives and Facility Managers to track jobs. 

 Store all data relating to the asset/cost centre, the type of work involved, and the labour, 
materials, equipment and resources used. 

 Enable Agencies and sites to accept and approve jobs for payment or dispute work as 
required. 

 Allow Facility Managers to enter two invoices, per month, for completed jobs. 
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In FAMIS, when work is submitted by an Agency Representative, a job number is issued for the 
work to be done.  The details are passed to the Facilities Management Service Provider (FM) for 
registration with their system.  The Agency deals directly with the FM.  The FM reports to DPTI via 
a daily file upload which contains claim information and other data requested. 

For more information on the FAMIS system, refer to the FAMIS Fact Sheet desktop aid. 

4.1 Planned Services 

4.1.1 Preventative Maintenance 

Preventative Maintenance comprises those FM Services undertaken to ensure that: 

 an asset continues to deliver the specific performance by the continued operation of
building fabric, plant and equipment as originally specified;

 the expected life of building fabric, plant and equipment is achieved by undertaking
maintenance at regular recommended intervals according to PR schedules and technical
data schedules where provided or, where appropriate, in accordance with manufacturers
recommendation’s and;

 systematic inspection, detection and observation takes place in a timely manner to prevent
premature failure.

Preventative maintenance also comprises those facilities management services undertaken to 
ensure that Statutory Requirements including requirements under Work Health and Safety (WHS) 
legislation are met. 

4.1.2 Planned Replacement/Refurbishment Maintenance 

Planned Replacement Refurbishment comprises those facilities management services involving 
replacement or refurbishment of building fabric and/or plant and equipment specified as part of a 
planned program. Planned RR: 

 comprises work costing $5,000 or more (exclusive of GST) but less than $1,000,000
(exclusive of GST); and

 is deemed necessary as a result of analysis of life cycle information or premature failure of
an item of building fabric or plant and equipment.

Planned RR may also be requested by the Agency Representative from time to time 

Refer to the Business Rules – Planned Works desktop aid. 
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4.1.3 Planned Minor Works 

Planned Minor Works comprises those facilities management services: 

 involving additions or modifications to existing buildings or upgrading of existing building
fabric, plant and equipment or new works at designated locations; and

 with an estimated value of $5,000 (exclusive of GST) or more but less than $150,000
(exclusive of GST); and

 mostly have a start date that is part of a planned program but can also be requested by the
Agency Representative from time to time.

Planned MW are designed to ensure that designated locations are supported and maintained to a 
standard that allows their operational and functional objectives to be achieved.  

Refer to the Business Rules – Planned Works desktop aid. 

4.1.4 Small Construction Works 

Small Construction Works comprises those facilities management services involving construction  
work costing $150,000 (exclusive of GST) or more but less than $1,000,000 (exclusive of GST). 
The limits for the values of SC are inclusive of construction costs and any costs to engage required 
professional services subcontractors. 

For the purposes of the FM Services Arrangements, construction work is defined as, “building work 
as defined in the Building Work Contractors Act 1995, including the whole or part of the work of 
excavating or filling of land not constituting building work. 
It; 

 includes the acquisition and installation of fixtures, plant, equipment, appliances and fittings
in conjunction with building work; and

 includes the acquisition of survey, planning, design and other services in conjunction with
building work; and

 excludes the acquisition of goods and services for the ongoing maintenance of a building or
structure”.

Small construction works must be undertaken in accordance with all Contract requirements. 

To raise a small construction works request, refer to the Requesting Small Construction Work in 
FAMIS work instruction. 



 

FAMIS Training & Business Rules Procedure v1.6 Page 8 of 32 

 

4.2 Unplanned Services 

4.2.1 Breakdown Maintenance 

Breakdown Maintenance comprises those Facilities Management services that: 

 are emergency services to repair failed plant and equipment or facilities that present  an 
immediate hazard to occupants of a Designated Location; or 

 are required to repair failed plant and equipment or facilities to ensure that the 
operational/functional objectives of Designated Locations are met. 

 

Breakdown Maintenance may be required: 

 in response to a breakdown callout; 

 as a consequence of a regular inspection of the asset; 

 as a consequence of failed items of plant or equipment identified whilst carrying out 
preventative maintenance; 

 upon request by the relevant Agency Representative; or 

 as an unplanned property service, e.g. cleaning of a spill/leak in the workplace. 

 
 
The Agency Representative is required to assign a priority from one to five when raising a BD job 
order. The Agency Representative must determine the priority level with regard to: 

 the likely impact on health, safety and welfare or security of the occupants of the 
designated location and; 

 the threat to the functional and/or operational objectives and availability of the designated 
location posed by the breakdown occurrence 

 
The priority level assigned to a BD job determines the time within which the FM Service Provider 
must attend the designated location to commence the required work. 
 
Call out fees apply to priority 1, 2, 3 and 4 jobs with priority 1 jobs attracting the highest call out fee. 
 

To view the Breakdown Maintenance priority levels and emergency maintenance examples, refer 
to the Unplanned Services Priorities and Processes desktop aid. 
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4.2.2 Scheduled Attendance Breakdown Maintenance 

Scheduled attendance breakdown maintenance is a new category of breakdown maintenance in 
the FM Services Arrangements commencing 1 July 2015. An Agency Representative can raise a 
scheduled attendance breakdown maintenance job where:  

BD is required; 

 the area within the designated location where the BD is required is not available for the FM 
Service Provider to provide services to; and  

 

 the BD is reasonably estimated as costing less than $2,000 (exclusive of GST). 
 
The Agency Representative must include in the work order the day and time at which the 
designated location will become available for the FM Service Provider to access and perform the 
required BD service. 
 
To raise a scheduled attendance breakdown maintenance work order, refer to the Requesting 
Scheduled Attendance Breakdown Maintenance in FAMIS work instruction. 

 

 

4.2.3 Unplanned Property Services 

The information and processes described below are provided to assist Agency Representatives 
responsible for the procurement of Property Services under the FM Services Arrangements. 
 
Property Services consists of: 

 Cleaning services (CL); 

 Hygiene services (HY);  

 Security services (SE)  

 Grounds maintenance (GR) 

 Waste management (WM). 

 
Responsive or unplanned property services including cleaning spills, immediate security 
requirements etc. can be procured as breakdown maintenance utilising the procedures to raise 
breakdown maintenance jobs.  

 

4.2.4 Unplanned Replacement/Refurbishment Maintenance 

Unplanned Replacement Refurbishment comprises those facilities management services involving 
the replacement or refurbishment of building fabric and/or minor plant and equipment. It may be 
required in response to the premature failure of an item of building fabric or minor plant and 
equipment, or could be identified by Agency Representatives or through the undertaking of other 
maintenance activities. 
 
Unplanned Replacement Refurbishment has a value of less than $5,000 (exclusive of GST). 
 
Refer to the Unplanned Services Priorities and Processes desktop aid. 
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4.2.5 Unplanned Minor Works 

 
Unplanned Minor Works comprise those facilities management services involving additions or 
modifications to existing buildings or upgrading of existing \building fabric, plant and equipment at 
Designated Locations. 
 
Unplanned Minor Works have an estimated value of $5,000 (exclusive of GST) or less. 
 
Refer to the Unplanned Services Priorities and Processes desktop aid. 
 
 

4.3 Property Services   

Property Services such as cleaning, hygiene, security, waste management and grounds 
maintenance can also be arranged through one of the two FM service providers - Spotless or 
Facilities Services. Property Services are largely procured through the use of Schedules of work in 
a manner similar to Preventative Maintenance. Exceptions include additional services which may 
be obtained as an unplanned job. 
 

 

4.4 AGFMA Hotline 

 

The FM Services Arrangements Hotline (the Hotline) provides dedicated telephone numbers for 
each region.  
 
The Hotline operates 24 hours a day, 7 days a week. Normal business hours are 7.30AM to 
5.00PM, Monday to Friday. Outside of normal business hours (i.e. 5:01PM to 7:29AM Monday to 
Friday, all day Saturday and Sunday and Public Holidays) the relevant Hotline number will divert to 
the FM Service Provider for that region. An out of hours call out fee and labour rates will apply 
outside of normal business hours. 
 
Table 1: FM Services Arrangements Hotline telephone numbers 
 
 
 
 
 
 
 
 
 
 
 
 
 
Refer to the AGFMA Hotline – Contact Details desktop aid. 
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5 FAMIS Access Level/Completing the Form 

Levels of access to FAMIS are available to suit the differing business needs of users, consisting of 
6 levels for Agency Users and 2 levels for Facilities Management Users. A single tick, in the 
appropriate box on the form, selects the level required. 
 
The following 6 levels of client access to FAMIS are available: 
 
Enquiry This level allows the user to view data only, but not add information or 

modify data. 
 
Job Request Allows the entry of a job request and release of a planned work, but does not 

allow acceptance or approval of work. From this level up it is possible to 
change the local asset description (Subject to DPTI AGFMA SECTION 
approval). 

 
Acceptance The user is able to accept as complete the job. This is the first tier of the 

two-tier system of job acceptance/approval. For further information, refer 
note below. 

Approval The user is able to approve for payment the job. This is the second tier of 
acceptance/approval. A user is also able to enter job requests etc. 

Approval only This level allows acceptance/approval but does not allow the user to enter 
jobs, thus providing a level of separation between the request of the work 
and the approval. This is used by some Agencies as part of their 
procurement processes. 

 
Full access The top level of access is primarily for corporate users and the DPTI FM 

Group. 

 
 
To complete the form and obtain access to FAMIS, refer to the Obtaining Access to FAMIS work 
instruction. 

 

Note: The two-tier system of acceptance and approval allows Agency Representatives the 
opportunity to separate the ability to request work from the ability to accept or financially approve 
work. This is a requirement of the Auditor General and it is a business decision of the agency as to 
how this process is managed. 
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6 Getting Started with FAMIS 

6.1 Logging On 

Refer to the Logging on in FAMIS work instruction. (Note: If users experience difficulties with the 
FAMIS system, please contact the DPTI Business Systems Service Desk on ph. 8343 2850 or 
email to: DPTI.BusinessSystemsServiceDesk@sa.gov.au 
 
 

6.2 Password Requirements 

To comply with Government Security Guidelines, FAMIS requires Users to change and maintain 
their own Password in accordance with FAMIS Password Requirements: 
 

Passwords must comply with the following: 

 All Passwords must be 8 characters or more 

 All Passwords must contain at least 1 number, 1 uppercase letter and 1 lowercase letter. 

 Users will be prompted to change their Password every 30 days (the system will allow 1 
grace login, per User) 

 Passwords cannot be re-used until 13 other Passwords have been utilised. 

 

Note: FAMIS will allow 3 login attempts; if users exceed 3 login attempts the system will lock 
User’s access. Users can reset their own password or if problems persist, users can contact the 
Business Systems Service Desk by telephone on 8343 2850 or by emailing 
DPTI.BusinessSystemsServiceDesk@sa.gov.au  to re-set and/or unlock User access. 
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6.3 Resetting a FAMIS Password 

If clients forget their password, the FAMIS system allows the users to reset their own password. 
FAMIS will allow 3 login attempts; if users exceed 3 login attempts the system will lock the User’s 
access and prompt a message stating to use the Forgotten Password button. Refer to the 
Resetting a FAMIS Password work instruction to reset a FAMIS password. 

6.4 Conventions 

Conventions for FAMIS are explained in a desktop aid explaining the keyboard functions, mouse 
actions, and terms used in all the FAMIS training modules. Refer to the FAMIS Conventions 
desktop aid to determine all the FAMIS conventions. 

 

6.5 Welcome Screen 

Upon login the FAMIS Welcome Screen provides Users with topical information and notices and is 
structured to provide easy navigation to Assets and associated work tabs. 
 
The screen layout consists of two panes. 

1. The left pane displays the Agency and Asset List. 
2. The right pane displays fields and information relating to the selected Asset. 

(Note: The display window will vary depending on the work tab selected). 
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The screen layout also consists of Closed Assets. 
 

 Closed Assets are displayed with a red folder. 
 
To view closed assets, select Closed Assets from the toolbar. (Note: New work cannot be created 
for a Closed Asset). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.6 The Asset List 

The Asset List displays in a hierarchical structure where the top most levels display the Agency 
names.  Refer to the Asset List Techniques desktop aid to learn the techniques to display details of 
the Asset List. 

 

6.7 The Work Tabs 

The Work Tab features consist of twelve working tabs displaying various levels of information. 
Tabs available are determined by a user’s access level. Refer to the FAMIS Work Tabs desktop 
aid to discover the twelve information tabs. 
 
 

6.8 Data Entry Techniques, Tips & Hints 

FAMIS data entry can be completed using the mouse or keyboard to access data entry fields. 
Refer to the FAMIS Data Entry Techniques, Tips and Hints desktop aid. 
 

6.9 Searching for Assets 

Finding Assets within FAMIS is quick and simple using one of following methods: 
 

 Navigate to an existing Asset 

 Search using the Toolbar Menu 
 
To find Assets within FAMIS, refer to the Searching for Assets work instruction. 
 
 

Display Window 



 

FAMIS Training & Business Rules Procedure v1.6 Page 15 of 32 

6.10 Setting up an Asset List 

The Asset List in the left-hand pane can be setup to display only those assets a User requires.  
Once a specific list is setup, FAMIS will record this detail and only display this list of assets in the 
Asset List pane upon User login. The Asset List tab opens with the current active profile. To set up 
an Asset List, refer to the Setting up an Asset List work instruction. 
 

6.11 User Contact Details 

User Contact Details are stored in FAMIS and must be kept up to date. 
 

To view/update user contact details, complete the folloiwng steps: 

1. Open the File Menu. 

2. Select Contact Details (the Contact Details window appears). 

3. Update details and click the  Submit  button. 

 

6.12 Logging Off FAMIS 

Users must complete any transactions or 
processes prior to exiting FAMIS. 

 

To log off the FAMIS system correctly, complete 
the following steps:                        

1. Open the File Menu. 

2. Select Exit.  
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Note: If a Warning dialogue box with the message, You have an unfinished Work Request 
transaction in progress. Please finalise before closing appears, complete the following steps: 
 

a) Click the  OK  button. 

b) Complete or Cancel any incomplete transactions.  

c) Exit the FAMIS system as per section 6.11 Logging Off FAMIS  

 

7 Work Requests 

7.1 Work Request Tab 

The Work Request tab screen displays various fields appropriate for the type of work being 
entered. Mandatory fields for data entry are highlighted in red. 
 
Note: not all of the fields are displayed for some Agencies. Some Agencies may only require some 
of the optional fields to be populated. 

 

 

 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select an Asset from 

the Asset List 

Click the Submit button to Complete 
Or 

Click the Cancel button to Cancel 

Complete the 
required fields 
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7.2 Unplanned Work 

Unplanned work consists of: 

 Breakdown Maintenance 

 Unplanned Property Services (e.g. Cleaning, Security etc.) 

 Unplanned Replacement/Refurbishment work (e.g. less than $11,000) 

 Unplanned Minor Works (e.g. less than $11,000) 
 

There are 5 priority levels available, depending on the urgency of the work for each 5 zones. 

Priority 1 

 Emergency request, can only be requested by telephone using the Hotline. 

 Attendance ranging between 45 minutes to 2 days (refer table below). 

 Highest call out fee and is intended only for emergencies. 

 
Priority 2 

 High priority request, can only be requested by telephone using the Hotline. 

 Attendance ranging between 2 hours to 3 days (refer table below). 

 High call out fee and is intended for work of high urgency. 

 
Priority 3 

 Attendance ranging betweeen same day if reported before 1 pm to 5 days. 

 Lesser call out fee and is intended for most medium urgency jobs. 
 
Priority 4 

 Attendance  ranging between 5 to 7 working days. 

 Lowest call out fee and is for work of a lesser urgency. 

 
Priority 5 

 Attendance is within a 30 calendar day maximum period. 

 No call out fee and is intended for low priority repairs. 

 

Priority Metro 

Regional South Australia Only 

Urban Outer Remote Isolated 

ALL PRIORITY 1 and 2 RESPONSES  MUST BE TELEPHONED ONLY 

1 
 

Within  
45 minutes  

1 hour 2 hours 
*Same day 
before 1PM 

2 days 

2 
Within 2 
Hours 

3 hour 4 hours 2 days 3 days  

3 
*Same day 
before 1PM 

*Same day 
before 1PM 

*Same day 
before 1PM 

5 days 5 days 

4 
Within 5 
working days 

Within 5 
working days 

Within 5 
working days 

Within 7 
working days 

Within 7 
working days 

5 
Within 30 
days 

Within 30 
days 

Within 30 
days 

Within 30 
days 

Within 30 
days 

*Same day if raised before 1PM if not by 1PM next day 

 After Hours 
Priority 1 

1 hour 1 hour 2 hour Same day 2 days 

Note: Allow  up to 30 Minutes processing time by Hotline 

 
 
To request unplanned work in FAMIS, refer to the Requesting Unplanned Work in FAMIS work 
instruction. 
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7.3 Planned Work (Releasing Planned Work) 
 
Planned work requests are usually for higher costs of work that include expensive equipment or 
construction work, which will take several weeks or months to complete. To release a planned 
work request, refer to the Releasing Planned Work Requests work instruction. 

8 Agreement (Planned Work Only) 

The Agreement tab displays a list of schedules, planned replacement/refurbishment works, 
planned minor works, and planned property services that are yet to be authorised by the Agency. 
When a submission is made through FAMIS for Planned Work, the Agency must authorise the 
agreement before the work order is issued. (Note: The FM can dispute this). When Agreements 
are authorised by the Agency, the Planned Work will appear in the Job Tracking tab the following 
day. The Agreement tab can also display jobs at the Agency level or for an individual Asset. 
 

 
 

8.1 Authorise, Dispute or Delete an Agreement 

Work agreements can be authorised, disputed and/or deleted along with many other options. Refer 
to the Action Options Pick List desktop aid and the Authorise, Dispute or Delete an Agreement 
work instruction. 
 

8.2 Clearing an Action 

The Clear button in FAMIS can be used to remove Action marks from displayed jobs. To clear an 
action mark, refer to the Clearing an Action Mark work instruction. 
 
Refer to the Action Options Pick List desktop aid. 
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8.3 Amending Work Details 

Work details can be viewed or amended from the Agreement screen. To view and/or amend work 
details, refer to the Amending Work Details work instruction. 
 

9 Job Tracking in FAMIS 

When any unplanned work has been submitted, or any planned work has been passed at the 
agreement stage, the work will appear in Job Tracking. Users can utilise many features from the 
Job Tracking tab, such as viewing the status of jobs, submit reworks, variations, consultancies or 
fixed price requests on planned (replacement/refurbishment or minor work) work. 
 
To view the status of jobs in progress, complete the following steps: 

1. Select the Asset from the Asset List pane. 

2. Select the Job Tracking tab from the Work Tabs pane. 

Note: The display window lists all the active jobs for the selected Asset. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Sorting Display Tables 
FAMIS display results can be sorted in either ascending or descending order by clicking on the 
column heading.  Multiple clicks will toggle between ascending and descending order. 
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9.1 Quick Menu Functions 

The Job Tracking display window provides a Quick Menu to access a range of job information 
details and actions. Users can long left-click on a job description to display the Quick Menu 
options.  Different menu items are available depending on the Job Type selected (e.g. Unplanned 
Breakdown Maintenance or Planned Minor Works. The Quick Menu is organised into 3 sections: 
Search Option, Display Options, and Actions Options. Refer to the Job Tracking Quick Menu 
Options desktop aid 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9.1.1 Search Option  

The Description Search section allows users to search for jobs by the Job Description text field.  
The Job Description field can contain up to 500 characters and the content can be searched using 
keywords that may not be seen from the Job Tracking display window. 
 
To search a job using the Job Description field, complete the following steps: 

1. Long left-click the Description Search action option. (Note: A Find Job by Description box is 
displayed). 

2. Enter a keyword and click the   OK  button. 

3. Press the F3 key to repeat the search. 
 
 

9.1.2 Display Options 

There are two options from the Display Options category that are primarily used in used in job 
tracking:  

 
Work Details 

The Work Details display option displays the details of the work to be carried out. 
 
Job Info 

The Job Info display option displays detailed informtion about the job (e.g. Job Number., Cost 
Category, Timelines, Contact details etc.) 
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To view or print work details or job information, complete the following steps: 

1. Long left-click on the job from the Job Description column. 

2. Select the required option from the Quick Menu. Note: A display window appears with the 
selected option result. 

3. Click the   OK  button to exit or the   Print   button to print a copy of the displayed information. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9.1.3 Action Options  

Job Notes 

Although, the Job Description field is limited to 180 characters, users can select the Job Note 
option from the Action Options section to provide more detailed information or for communication 
purposes with other parties regarding the selected job (unlimited characters). To add a job note, 
refer to the Adding a Job Note work instruction. 
 
 
Amend 

Users can select the Amend option from the Action Options section to amend agency 
information/work details for a job in progress. To amend work details, refer to the Amending Work 
Details work instruction. 
 
 
Variation (Planned Work Only) 

Users can select the Variation option from the Action Options section to add a variation to Planned 
Work. Variations can be added to Planned Work (e.g. replacement/refurbishment works or minor 
works) with a Fixed Price. Variations are attached to the primary or main Job Number. To add a 
variation to planned work, refer to the Adding a Variation work instruction. 

 
 
Rework 

Users can select the Rework option from the Action Options section request the work to be re-
done, only if the work was not completed satisfactorily.  Reworks are used at the Trade level and 
can be applied to all classes of jobs. Reworks are undertaken by the FM at no cost to the client. To 
request a rework of a job, refer to the Requesting a Rework work instruction. 
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Consultants (Planned Work Only) 

Consultancies can only be created and appear on Planned Work (e.g. replacement/refurbishment 
work or minor work). To add a consultancy to Planned Work, refer to the Adding a Consultancy 
work instruction. 
 
 
Fix Price (Planned Work Only) 

Fixed Pricing is only available on Planned Work. (e.g. planned replacement/refurbishment work or 
planned minor work). Fixed Pricing is mandatory on all planned work on receipt of the acceptable 
formal tender recommendation from the FM, the Agency Representative will provide written 
acceptance of the recommended offer submitted and will approve the works to proceed into 
construction and approve the extension of any consultancy services for contract administration of 
the construction phase, by increasing the agreed fixed price in FAMIS accordingly. The FM will not 
be able to make progress claims for work until a Fixed Price is entered.  
 
To enter fixed price details, refer to the Entering Fixed Price Details work instruction. 

 

9.2 Cancelling a FAMIS Job 

If a FAMIS job is incorrectly entered or no longer required, the client has the ability to request 
cancellation of the job request. (Note: If billing has occurred, it cannot be cancelled. FAMIS job 
cancellations must also be Contract Compliant.  
 
To cancel a FAMIS Job, refer to the Cancelling a FAMIS Job work instruction 

10 Approvals 

10.1 Approvals for Payment 

The FM Service Provider makes financial claims during the month for work completed or in 
progress through submitting invoices to FAMIS. 
 
To comply with the requirements of the Contract/Framework, when a claim is received in FAMIS, it 
must be accepted and approved, or disputed, by an authorised Agency Representative within 30 
days of being received.  
 
Only claims that have been accepted and approved by an Agency Representative are included in 
the payment by the Contract Administrator to the FM Service Provider at the end of each fortnightly 
payment period. 
 
All claims that are not accepted and approved, or disputed, within this 30 day period are “auto-
approved” by FAMIS. It is imperative that Agency Representatives at designated locations and 
Corporate Agency Representatives, at least weekly, access FAMIS to accept and approve work 
claims submitted by the FM Service Providers. After 20 days, a daily countdown will occur to alert 
users of all claims for which auto-approval is pending.  
 
If a job has been disputed no payment will be made to the FM Service Provider and the job will 
appear on the disputed jobs lists. The reason(s) for which a claim is being disputed must be 
provided at the time of raising the dispute. Upon resolution of the dispute by the Agency 
Representative and FM Service Provider, payment for the job will be made to the FM Service 
Provider and it will no longer appear on the disputed jobs list. 
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Note: Acceptance and Approval functions are for financial payment to the FM for work undertaken 
at the request of the Designated Location. It is not the authorisation for an Agency to charge the 
work to a Designated Location.  This is a matter between the Agency and the Designated Location 
to be decided internally and must not be confused with the payment of the FM as a third party.  
 

DPTI will provide monthly reports to Agencies detailing all jobs that have been automatically 
approved for payment. After 20 days, a daily countdown will occur to alert users of pending auto 
approval.  

 

10.2 Auto Approval Notification 

Clients will receive an Auto Approval Notification via email listing all jobs that are due to be Auto 
Approved in FAMIS within 15 days or less. The Auditor General requires all jobs to be accepted 
and approved before invoicing. No claims are to be auto approved. 
 

10.3 Display Job Details on the Approvals Tab 

The Approvals tab display window provides a Quick Menu to access a range of job information, 
details and billing. To access the Quick Menu, long left-click on the job number to display the Quick 
Menu, then select the required Quick Menu item. A display window demonstrates the selected 
option result. 
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10.4 Accept, Approve or Dispute Claims for Payment 

To accept, approve or dispute claims for payment, refer to the Accepting, Approving, Disputing 
Claims for Payment work instruction. 
 

10.5 Clear Disputes on Claims for payment 

To clear disputes on claims for payment, refer to the Clearing Disputes on Claims for Payment 
work instruction. 
 
 

11 Job History 

11.1 Job History Details 

When any scheduled, planned or unplanned work has been completed, the work will appear in the 
Job History tab. Job History enables users to view the status of any completed job, including 
financial details and/or cancelled jobs for any asset covered by the FM arrangements. Details 
displayed on the Job History tab are similar to the Job Tracking tab with an additional feature of a 
between dates filter, to limit the number of jobs displayed. Users can only issue a rework from the 
Job History tab; no other changes can be made to the jobs within this display. 

 

11.1.1 View the History of a Completed Job 

To view the history of a completed job, refer to the Viewing Completed Job History work 
instruction. 
 

11.1.2 Sorting Display Tables 

FAMIS display tables can be sorted in either ascending or descending order by clicking on the 
column heading.  Multiple clicks will toggle between ascending and descending order. 
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11.1.3 Quick Menu Options 

The Job History tab display window provides a Quick Menu to access information relating to closed 
jobs, cancelled jobs and financial details, similar to the Job Tracking Quick Menu feature. To 
access the Quick Menu, users can long left-click on a job in the display window to display the 
Quick Menu.  Different menu items are available depending on the Job Type selected.  

 

The Job History Quick Menu can be used to view or print: 

 Work Details – displays details of the work to be carried out. 

 Job Info – displays detailed information about the job (e.g. Job no., cost category, timelines, 
contact details etc.) 

 

Other Job History Quick Menu items also display various expense and billing summaries for each 
completed job: 

 Expense 

Summary – 
displays details 
of job expenses. 

 Billing Summary 
– displays details 
of job billings. 

 Account 
Summary – 

displays an 
overall account 
summary. 

 
 
 
 
 
 
 
 
 
 

11.1.4 Export Information to Excel 

Some Job History Quick Menu items enable users to export the job details to Excel for further 
analysis.  The Job History Quick Menu can be used to export: 

 Job Expenses – displays job expense details. 

 Job Billing – displays billing summary information. 
 
 
To export job expenses and/or job billing details, refer to the Exporting Job Expenses/Bill Details 
work instruction. 
 

12 Job Billing 

12.1 Job Billing Details 

The Job Billing tab displays requests for payments, received from the Facilities Managers in 
various stages, ranging from awaiting acceptance through to completed payment.  
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12.1.1 View the Billing Details of a Job 

To view the billing details of a job, refer to the Viewing Job Billing Details work instruction. 
 
 
 
 
 
 
 
 

12.1.2 Claim Types 

To view claim types of a job, refer to the FAMIS Claim Types desktop aid. 
 
 
 
 
 
 
 

 

 

 
 
 
 
 

13 Invoicing 

13.1 View Invoices as an Agency 

Once claims have been approved in the Approvals tab, they are then ready for Invoicing by the 
Facilities Manager. Claims to be invoiced are visible from both the Approvals tab and the Invoicing 
tab.  Access to these tabs is dependent on the user access permissions and may not be available 
to all users.  

 

To view jobs ready for invoicing, as an Agency, refer to the Viewing Jobs for Invoicing – Agency 
work instruction. 

 

13.2 View Invoices as a Facilities Manager (FM) 

The Facilities Managers have a similar view from the Invoicing tab with additional functionality to 
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raise Invoices. The FM will select the claims to be included on a Tax Invoice and assign an invoice 
number to the group of claims. This produces an invoice for payment to the Facilities Management 
Provider. 

 

To view jobs ready for invoicing, as a Facilities Manager, refer to the Viewing Jobs for Invoicing – 
Facilities Manager work instruction. 

 

14 Work Schedules 

14.1 Work Schedule Details 

At any time, users can view all schedules for an Asset including past and current year’s programs. 
The work schedules for Preventative Maintenance work and Property Services, as identified in the 
Technical Data Sheets (TDS), shows a break-up of each program by service discipline. 

 

14.1.1 View a Schedule of Work of Preventative Maintenance Work 

To view a schedule of preventative maintenance work, refer to the Viewing Preventative 
Maintenance & Property Services Work Schedules work instruction. 
 

14.1.2 View Schedule Details of Property Services 

To view schedule details of property services, refer to the Viewing Preventative Maintenance & 
Property Services Work Schedules work instruction. 
 

15 Budgets 

15.1 Budget Details 

Users can view Budgets for each type of job and for each month of the year.  Budgets are 
available for Preventative Maintenance and Property Services and can also display aggregate 
budgets by discipline. 

 

15.1.1 View Budgets by Month/Year 

To view a budget for a type of job for each month/year, refer to the Viewing Budgets work 
instruction. 
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16 Troubleshooting 

16.1 Recognise Error Messages 

Error messages appear when the system cannot complete a task due to incomplete transactions 
being present on a previous asset. Error messages will be displayed in a FAMIS box with a 
description and/or prompt to correct the problem. 

 
To recognise error messages, complete the following steps: 

1. Take note of the action required. 

2. Click the   OK    button to exit the FAMIS error message box. 

3. Navigate and correct the error. 
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16.2 View Reported Bugs 

To assist users with overcoming problems with FAMIS, users can view a list of previously reported 
problems using the system Bug List.  This list provides a description and resolution for each Bug. 

 
To access the system Bug List, complete the following steps: 

1. Click on the Help Menu list. 

2. Select Bug List from the Help Menu list. (Note: A List of Reported Problems box will be 
displayed). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

16.2.1 Enter a New Bug or Problem 

To enter a new bug or problem, complete the following steps: 

1. Click the File Menu option. 

2. Select Reported Bugs. 

3. Select a Reference option from the Reference pick list/dropdown list. 

4. Enter a brief description of the problem in 
the Details box. (Note: Include user 
name and contact phone number). 

5. Complete the Contact Name and 
Telephone Number fields. 

6. Click the   Submit   button to report the 

Bug. 
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16.3 Display the About Screen 

The About screen displays information about FAMIS, including the current version release and 
Facility Management contact details. 

 
To view the About screen, complete the following steps: 

1. Click on the Help Menu. 

2. Select the About option. 

 

 

 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 

16.4 View New Features of FAMIS 

The New Features screen displays a list of new features available in the current version of FAMIS. 

 
To view the New Features screen, complete the following steps: 

1. Click on the Help menu. 

2. Select the New Features option. 
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17 Reports 

17.1 Report Details 

There is a selection of Reports available from FAMIS with the added feature to export the results to 
Excel for analysis or printing. 

 
To access reports, complete the following steps: 

1. Click on the Reports menu. 

2. Select the required period (e.g. New Jobs Within etc) from the Reports menu. 

 
Note: The results appear in a separate display window. 

3. Select the Export to Excel button. 

4. Follow the system prompts to save and access the excel file or select the OK   button to exit. 
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